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Browsers, Plug-ins and Web sites

Three different kinds of tools:

- Browsers. The best tool for seeing how a site
performs is a browser. In 2011, the most
popular browsers were Internet Explorer 8 and
9, Firefox 3 and 4, Safari 4 and 5, and Webkit
[ Webkit is the basis of Safari, Chrome, and
most smartphone and tablet Web browsers]

» Plug-ins: Firefox is the leader in browser plug-
ins

- Web sites as tools: many Web sites help you
build or evaluate Web sites



Free Web Tools: Ghostery

Ghostery is a Firefox/Safari/Chrome/IE
plug-in that tracks Web bugs
a Ghostery 2.5.3

by David Cancel, Felix Shnir

Protect your privacy. See who's tracking your web browsing and block
them with Ghostery.

View privacy policy

Updated April 20, 2011

Website http://www.ghostery.com/
Add to collection

Works with Firefox 3.5 - 7.0a1
Share this Add-on

Rating 298 reviews

Downloads 2,418,194




Free Web Tools: Ghostery I1
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Free Web Tools: Ghostery 111
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Free Web Tools: Ghostery IV

B 1trackers

debris

National Marine
Sanctuary
System

# Ghostery found the following:
What is ForeSee? ForeSee >

http://oceanservice.noaa.gov/fo... Web Bug Blocking
Cookie Protection
Block ForeSee?
Help

Coastal Options

Decision- Whitelist domain
making Tools

nse

Share Ghostery
Update bug lists

Give us feedback

About Ghostery
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Free Web Tools: Wappalyzer

« Wappalyzer uncovers technology used to
build a site.

Add-ons for Firefox > Extensions > Wappalyzer

Wappalyzer 1.13.2

by ElbertF
Wappalyzer is an add-on for Firefox that uncovers the technologies used on
websites.

View privacy policy

The developer of this add-on asks that you help

@ Add to collection support its continued development by making a

Share this Add-on small contribution.

Suggested Contribution: $5.00

What's this?

Updated April 20, 2011

Website http://wappalyzer.com
Works with Firefox 3.5 - 6.

Rating 35 reviews

Downloads 162,910 View Statistics



Free Web Tools: Wappalyzer 11

« Wappalyzer puts icons in the location bar.
Clicking the icon takes you to a Wapalyzer
page with information on that technology.

NOAA's National Ocean Service

\'/ http://oceanservice.noaa.gov/
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Free Web Tools: Web Developer

» Large toolkit for Web developers

» Disable cache, images, Java, JavaScript,
CSS for site checks.

» Display alt tags, image dimensions, file
sizes.

« View document outline, size

» Validate HTML, CSS, Section 508

»« Many other features
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Free Web Tools: Web Developer 11

» Disable styles

@ Disable ~ # CSS v = Forms ~ @ Images ~ 6 Information ~ [ . Miscellaneous ~ ,‘ Outline ~ |13/ Resize ’ Tools ~ — View Source v |[}| Options ~
Disable Styles 2 All Styles ®OS

Display CSS By Media Type » Browser Default Styles

View CSS #¥0C RATION
View Style Information #4Y Embedded Styles MERCE

Inline Styles
» About NOAA  Add User Style Sheet... Linked Style Sheets » SEARC

/ Edit CSS #OE 7
Use Border Box Model Print Styles Deepwater I-Iorizon Archlve | Assessment + Restoration | Seafood

REST . Individual Style Sheet . n——— '“-- Quick Links --

Weather.gov Forecast EXPLORE NOAA

NOAA NEWS All Release
» NOAA In Your State NOAA, coastal states discuss U.S. tsunami

w

» Working With NOAA
» Media & Constituents

capabilities, local preparedness needs

» Budget Information
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Free Web Tools: Web Developer III

» Disable styles

_ NATIONAL OCEANIC AND
W ATMOSPHERIC ADMINISTRATION

Mt o#

About NOAA
Contacts

Staff Directory
Help

Search Criteria

» SEARCH

NOAA Deepwater Horizon Archive | Assessment + Restoration | Seafood Safetv

Quick Links [ -- Quick Links -~ -+

L
Weather.gov Forecast
City, ST Eg

o Active Weather Alerts




Free Web Tools: Web Developer 1V

» View outline

@) Disable ~ » €SS v = Forms v [ Images v () Information ~ [} Miscellaneous v ,* Outline v 13| Resize ~ ?j Tools v

% NOAA National Marine Sanctua... € | | | Dot Display Abbreviations
Display Access Keys
Display Anchors

=< NAT, ONAJ &t ICTUARIES
ﬁ;\ Display Div Order
™ A ( Display Element Information $#GF
i Display Id & Class Details
Display Link Details
Display Object Information ::.::‘,
Display Stack Levels i ';"t:

Display Tab Index sures.

Display Table Depth
Display Table Information

Display Title Attributes
Display Topographic Information

Please help protect ol » 1 itional marine
sanctuary system. Te  VIeW Anchor Information a $10 donation

to the National Marin  \/ijew Color Information ‘ocean.org for

more Information.
View Document Outline

Latest Sanc View Document Size

e~




Free Web Tools: Web Developer V

» View outline

@) Disable v o CSS v = Forms v = Images v () Information v [} Miscellaneous v ,* Outline

% NOAA National Marine Sanctua... € | [ | Document Outline - http://san...

= Collapse All + Expand All

[Missing Heading]

[Missing Heading]
«3> Latest Sanctuary News




Free Web Tools: Web Developer VI

 Document size

@ Disable v » CSS v = Forms v [ Images ~ 6 Information ~ [ L Miscellaneous v , * Outline v |13/ Resize ~ } Tools v

NOAA, Ocean Explorer Display Abbreviations
Display Access Keys
Display Anchors
Display Block Size
Display Div Order
Display Element Information ¢
e - M Display Id & Class Details

L)\PL()RAI l()NS GALLERY IL(,HNOL()( . v .

- ' Display Link Details
Display Object Information
Display Stack Levels
Display Tab Index

A team of some of the world’s forer
art dlvmg equipment to explorer Be

Display Table Depth
Display Table Information

Display Title Attributes
Display Topographic Information

View Anchor Information
View Color Information

'y View Document Outline
EDUCATION C




Free Web Tools: Web Developer VII

 Document size

Documents (1 file) 11 KB (50 KB uncompressed)

Images (42 files) 802 KB
Objects (2 files) 870 KB

Scripts (2 files) 853 bytes
Style Sheets (2 files) 3 KB
Total 1686 KB (1725 KB uncompressed)




Free Web Tools: Link Evaluator

« Automate link checking.

Add-ons for Firefox > Extensions > Link Evaluator

Link Evaluator 0.9.9.7

by Filip Babalievsky

e Link Evaluator works as an enhanced Link Checker. When started, it

attempts to download the Web page behind each link and searches for 2
customizable sets of phrases - one for "red-flag” phrases and one for

"green-flag” phrases.

Add to collection Updated May 21, 2009

Share this Add-on Website http://evaluator.oclc.org
Works with Firefox 1.5 - 6."
Rating 21 reviews

Downloads 113,451




Free Web Tools: Link Evaluator 11

National Geodetic Survey (NGS) Select All
Geodesy is the science of determining the size a
location of points upon its surface...

View Source Chart

View Page Source
NOAA Coastal Services Center (CSC) View Page Info
The NOAA Coastal Services Center provides skill
state and local coastal resource managers... “&’ Inspect Element

Link Evaluator Control Panel

Office of Coast Survey (OCS) Feanrate TInce
The Office of Coast Survey (OCS) is the nation's

Office of National Marine Sanctuaries (ONMS) Web Developer o

The Office of National Marine Sanctuaries protects and manages 14 marine
protected areas encompassing over 150,000 square miles...

Office of Ocean and Coastal Resource Management (OCRM)
The Office of Ocean and Coastal Resource Management (OCRM) is responsible
for implementing the Coastal Zone Management Act (CZMA) of 1972...

Office of Response and Restoration (OR&R)
The Office of Response and Restoration (OR&R) works to prevent and mitigate
harm to coastal resources...

(top)




Free Web Tools: Link Evaluator II1I

Management and Budget Office (MBO)
The Management and Budget Office serves as the focal point for all NOS
management and budget activities...

(top)

NOAA Sites

National Oceanic and
Atmospheric Administration

National Environmental
Satellite, Data & Information
Service

National Marine Fisheries
Service

National Weather Service
NOAA Research

NOAA Library
NOAAWatch

NOAA Careers

NOAA Staff Directory

Revised April 21, 2010 | Questions, Comments? Contact Us | Report Error | Disclaimer | ADOUEthe S

NOS Program Offices

Center for Operational
Oceanographic Products and
Services

National Centers for Coastal
Ocean Science

NOAA Coastal Services Center
National Geodetic Survey
Office of Coast Survey
Office of National Marine
Sanctuaries

Office of Ocean and Coastal
Resource Management
Office of Response and
Restoration

NOS Headquarters
For NOS Employees
Equal Employment

Opportunity and Diversity
Programs

Integrated Ocean Observing
System Program

International Program Office

Management and Budget
Office

] @ web Site Owner: National Ocean Service | National Oceanic and Atmospheric Administration | Depar
~ http://oceanservice.noaa.gov/programs/welcome.htmi




Free Web Tools: Safari Web Inspector

» Safari includes Web developer tools, but
they must be turned on in Preferences

Advanced

YoXa
— - —— Y () Py @
T O B[ i
General Appearance Bookmarks Tabs RSS  AutoFill Security Extensions Advanced

Q v

Universal Access: | | Never use font sizes smaller than
| Press Tab to highlight each item on a webpage

Option-Tab highlights each item.

Style sheet: | None Selected

Proxies: [ Change Settings... 1

[Z‘ Show Develop menu in menu bar

: 0} A S T ) , H E A L I H Y E (& 0] I\ 0 M | E )



Free Web Tools: Safari Web Inspector 11

New menu appears in tool bar

IDeveIop Window Help

Open Page With
User Agent >

Show Web Inspector
Show Error Console
Show Snippet Editor
Show Extension Builder

Start Debugging JavaScript
Start Profiling JavaScript {r36P

Disable Caches

Disable Images

Disable Styles

Disable JavaScript

Disable Runaway JavaScript Timer
Disable Site-specific Hacks




Free Web Tools: Safari Web Inspector III

» Load
time
histogram

Web Inspector — http://webstats.nos.noaa.gov/

—1 3= 7¥ 7 .- 1]
) b=l 5 C [dea
Elements ' Resources Scripts Timeline Profiles Storage Console

a7 |
(5 | Documents

Search Resources

Stylesheets Images Scripts XHR Fonts Other

GRAPHS

Documents [ Stylesheets
40ms 29ms

Images [ Scripts Total
352ms 64ms 377ms

RESOURCES

] http:/ /webstats.nos.noa...

ocean-web-toolsl.jpg
[siteart

= exit.js
lis

leftcol_bkgrnd2.jpg

/siteart
mtblsans.jpg

webcollagesm2.jpg

Jimages

| webshopwordle2011150...

eference

itr-clean.qgif
wwweInternetTrafficReport.com

Silver_Spring.gif

weathersticker.wunderground....

- | Seattle.gif
weathersticker.wunderground....

\"’ favicon.ico

Sort by Response Time %



Free Web Tools: Safari Web Inspector IV

®O6 Web Inspector — http://webstats.nos.noaa.gov/

» Load
size

histogram

<2 - e O C k) [

Elements ' Resources Scripts Timeline Profiles Storage Console Search Resources

.\ Documents Stylesheets Images Scripts XHR Fonts

GRAPHS

Time

- Documents Images Total
&' Size 12.21KB 10.28KB 22.49KB

RESOURCES

‘ http://webstats.nos.noa...

tr-clean.gif
www.InternetTrafficReport.com

Seattle.gif
athersticker.wunderground....

1 Silver_Spring.gif

weathersticker.wunderground....

favicon.ico

nosemp.css
exit.js
fis

noaa-logol.jpg

[siteart

ocean-web-toolsl.jpg
[siteart

leftcol_bkgrnd2.jpg

[siteart

1 webshopwordle2011150...

[reference

webcollagesm2.jpg

/images




Free Web Tools: Safari Web Inspector V

®Oe

Web Inspector — http://webstats.nos.noaa.gov/

5] = {3z (0% ‘(\ = pm
o Inspect Eﬁﬁi}ts Re\s:—jces Sﬁs T%e Pb:i;s S%:e C:ﬁe =
element

Search Elements

oceanservice.noaa.gov/" title=

"National Ocean Service Web

Site

¥<a hr

Analyti
<img src="/siteart/ocean-web-
toolsl.jpg" alt="National Ocean
Service Web Tools and
Analytics" width="709" height=
86" border="0" title=
“"Fulfilling our motto of 'Zeros
and Ones for Science' since the
Twentieth Century"=>

<link rel="alternate"
"application/rss+xml"
Web Stats [RSS]" | s nr
P Metrics

P Properties

P Event Listeners

- End
iv id=

Q  html body div#wrap div#header




Free Web Tools: Firebug

- Firebug is a Firefox Add-on that gives you a wealth of

development tools in your browser. You can edit, debug, and

monitor CSS, HTML, and JavaScript live on any web page.

Add-ons for Firefox > Extensions > Firebug

«2 Firebug 1.7.2

v by Joe Hewitt, johnjbarton, robcee, FirebugWorkingGroup, Jan Odvarko

Firebug integrates with Firefox to put a wealth of development tools at your fingertips while you
browse. You can edit, debug, and monitor CSS, HTML, and JavaScript live in any web page...

This is our production release. For Firefox 4.0b, see below.

O Firefo.

(3 Add to collection

The developer of this add-on asks that you help support its continued

Share this Add-on
development by making a small contribution.

Suggested Contribution: $10.00

What's this?

Updated
Website
Works with
Rating

Downloads

June 2, 2011
http://getfirebug.com/
Firefox 3.6 - 5.

1,044 reviews

36,670,593 View S


http://getfirebug.com/

Free Web Tools:

Firebug II

« HTML panel of current markup

““ .—1JJ ( ’ ‘ -
<>' Edit | « div#fancybox-overlay - body®home - html - docr®

= <div id="wrap"
= <div

+ <ul id="nav">

<div id="logo-
install"™ eclass="group">

Console  HTML~v (SS Script DOM

class="group"> -

id="header" class="group">

= <div id="logo">
<a href="/"></a>
<hl1> [ERTIr |/hl>
<hZ>Web Development
Evolved. </hZ>

</div>
+ <div id="install"

</ div>

m

0

Computed
tfoort,
th,

Net

Style v
tbody,
thead, tr,

Layout DOM

td {

baseline;

}
Inherited from bodyghome

body { master.css (line 26)




Free Web Tools: Firebug III

» Net panel monitors HTTP communication

Console HTML CSS Script DOM Net - p

Persist' All| HTML €55 J5 XHR Images Flash Media

®r S \ (

e | Clear

GET secondai
GET divider.p
GET Titilliump
GET Titilliump
GET Intro2FB
GET del-linkre
GET firebugn«
GET mozilla-k
GET footer-b«
GET firebug-t
GET Intro2FB

GET Intro2FB.

getfirebug.com
getfirebug.com
getfirebug.com
getfirebug.com

=nt getfirebug.com

|.yimg.com

feeds. delidous.com

getfirebug.com
getfirebug.com
getfirebug.com

¢ getfirebug.com

getfirebug.com

130 B
1.3KB
26.3KB
26.4KB
14KEB
2.5KB
1KB
989 B
3138
1.2KB

4.7KB
7 M

38 requests 262.5 KB (25.7 KB from cache)

Transferring data from getfirebug.com...




Free Web Tools: Firebug IV

» Console panel with an example error log

& L'l £ \ | Consolev HTML (CSS Script DOM  Net P

@ ' Clear Persist Profile || All| Errors Wamings Info Debuglnfo
€) missing ; before statement
28eCzrNotZBe (40) test.html (line 1)
¥)This is a warning! test.html (line 38)
€) * foops is not defined
foops(); 3 (line 2)
€ = B3is not defined
badStuff() test.html (line 263)
deepError() test.html (line 258)
+ ondick(event=click clientX=256, clientY=60) 4 (line 2)
f*foo*/ B3(); test.html (line 263)
0 uncaught exception: hi
>>>

Done € 5 Errors




Useful Web-based tools
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https://webdeveloper.nos.noaa.gov/
https://forum.webcontent.gov/
http://www.howto.gov/web-content
http://www.w3counter.com
http://pagespeed.googlelabs.com/
http://www.google.com/trends
http://section508.gov/
http://wave.webaim.org/

